
 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

User Manual 
Updated for Version 1.4 



SOFTWARE LICENSE AGREEMENT 
IMPORTANT – READ CAREFULLY 
This is a legal agreement between you (either an individual or a single entity) and Timestone Software. By keeping this 
package and using the software, you are accepting the terms and are bound by the terms of this license. If you do not wish to 
enter into this agreement, please promptly return all copies of the Software, User Guides and Hardlock devices to Timestone 
Software for a full refund. This User Guide and the software programs it describes are protected by copyright, trade secret 
and trademark law. By accepting this license, you have the right to use them, subject to the terms and conditions of this 
license agreement. 

Definitions and Interpretation 

♦ 

♦ 

♦ 

♦ 

♦ 

♦ 

♦ 

Software means the Program modules enabled and authorised for use for your installation. 

Hardlock device means the hardware device used to enable the Software to function. 

Scope of Agreement 
Timestone Software hereby grants you, the original purchaser, personal, non-exclusive license to use the User 
Guide and the Software subject to the terms and conditions of this Agreement. 

Grant of License. You may use the Software on a maximum of one computer that you own or operate at a single 
physical location . You may transfer the Software from one computer to another provided that you do not use or 
permit the usage of the Software on more than one computer or computer terminal at a time. 

Copies. You may not copy or duplicate the Software, except as necessary solely for archival purposes, program 
error verification, or to replace defective storage media, provided you keep the original and the copies. You may 
not alter, decompile or disassemble the Software. 

Transfers. You may not sublicense, lease or rent or lend the Software or transfer any of your rights under this 
Agreement. You may transfer the Software (together with any backup copies you have made), Hardlock device 
and the User Guide on a permanent basis so long as you retain no copies, the transferee agrees to be bound by the 
terms of this Agreement, and Timestone Software has authorised the transfer by written confirmation. 

Term. The License granted in this agreement is effective until terminated. You may terminate it at any time by 
destroying or returning to Timestone Software the Software and the User Guide, together with all copies, and 
returning to Timestone Software the Hardlock Device. If you fail to comply with any term or condition of this 
Agreement, this License will terminate and, upon such termination, you agree to destroy or return to Timestone 
Software the Software and the User Guide, together with all copies, and return to Timestone Software the 
Hardlock Device. Termination of this license shall be in addition and not in lieu of any other remedies available 
to Timestone Software. 

Limited Warranty, Disclaimer 
Timestone Software warrants that the media on which the Software is recorded and the User Guide provided with it are free 
from defects in material and workmanship under normal use for a period of 90 days from the date of your original purchase. 
Except for the limited warranty described above, the Software is sold “as is”, and you are assuming the entire risk as to its 
quality and performance. It is your responsibility to verify the results obtained from the use of the Software. 

Limitation of Remedies 
If during the 90-day limited warranty period, you discover physical defects in the User Guide or in the Media on which the 
Software was recorded, Timestone Software will replace them as no charge to you. This is your sole remedy. 

IN NO EVENT WILL TIMESTONE SOFTWARE BE LIABLE TO ANY PERSON FOR ANY DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR SIMILAR DAMAGES, EVEN IF TIMESTONE 
SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
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efore you Begin 

Scope and audience 
This manual covers both operation and technical aspects required to use PrintTime. The 
manual is divided into several chapters – see the Table of Contents at the start for a broad 
sweep.  Alternatively, consult the Index for specific procedures. 

Getting more help 
More help is available for PrintTime from the following places: 

Help pages from our WWW site, http://www.timestone.com.au ! 

! 

! 

! 

! 

! 

! 

! 

! 

! 

Technical support as noted at the end of this chapter 

Pre-installation requirements 
You will need to following resources and information before you start installing 
PrintTime: 

PrintTime software installation CD-Rom 
PrintTime software user’s guide 
Hardware protection device 
‘Unlock’ code supplied by Timestone Software 
Your computer complies with the hardware and software specifications 
as outlined in Chapter 2, Installation. 

Learning PrintTime 
Included on the PrintTime CD-Rom are contained the following resources: 

Installation files 
PrintTime user manual – the document you are currently reading 
Tutorial files 
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We strongly recommend that you read the major sections of this manual before using the 
software. 

Getting help from Technical Support 
We offer many different methods of support. However, we strongly encourage you to use 
e-mail as your primary support mechanism. 

Telephone support 
Telephone support is available by calling Timestone Software during our business hours. 
These hours are: 

9:00 AM – 5:00 PM Australian Eastern time 

The telephone numbers are: 

Voice: + 61 3 9570 9899 

Fax support 

" You can fax us with questions or queries. Please address your fax queries to Technical 
Support. The fax number is: 

Fax: + 61 3 9570 9855 

E-mail and WWW support 

/ 

There are support pages that include links to the newest versions of the software, as well 
as user documentation, and ‘Frequently Asked Questions’. 

Our WWW and e-mail contacts are: 

P

! 

http:/
☎

WWW: http://www.timestone.com.au 
E-mail: support@timestone.com.au 
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ystem Requirements 

Hardware requirements 
The following hardware requirements are required as a minimum configuration to run 
PrintTime. You should always attempt to exceed these requirements. 

If you have a choice in areas that you can afford to exceed these requirements: do this in 
the following order: 

Memory ! 

! 

! 

! 

! 

! 

! 

! 

! 

! 

! 

! 

! 

! 

! 

! 

! 

CPU class (Pentium II, Pentium III) 
CPU Speed 
Hard disk speed (Ultra, Ultra Wide, RAID) 
Other 

Minimum requirements 
Intel Pentium II processor at 350 MHz 
100 MHz system motherboard (Bx class) 
128 Mb RAM 
4Mb Video card (1024 x 768 @ 24 bit – see note) 
9Gb Hard Disk (see note) 
10 / 100 Ethernet card 
33.6k Modem 
High quality (Sony, Apple) 17" color monitor 
Windows NT 4.0, Service Pack 3 
Mouse with mouse wheel (Microsoft, Logitec) 

Optional Extras 

6 x 9cm Graphics Tablet with pressure sensitive stylus (Wacom) 
CD-R or DVD RAM drive for data backup 

 

Chapter 2 – System Requirements Page 3 



Notes 
Video Card: It is most important to use a high quality video card. In particular, you 
should use video cards that support monitor calibration in some manner. Typically, 
manufacturers such as ATI or Video Seven have such products. 

Hard disk: If you are using PrintTime on a single workstation, you should realise that 
very quickly you will use 9Gb of data storage, just with the images you scan to create your 
products. If your requirements are low volume, you could consider a single 9Gb hard, and 
continually move images that are finished onto a CD-Rom or DVD-RAM disk. However, 
if you are producing just an average number of packages, you will want to use a number 
of drives. Fortunately, hard disk drive costs are relatively low today. 

 

 

PrintTime – Chapter 2 – System Requirements Page 4 
 



3 – In

 

PrintTime – 
 

3

stallation 

Open the CD-Rom in Windows Explorer or My Computer, and double-click the file, 
Install PrintTime. The installer 
screen appears. 

The installation process may 
require a restart mid-way 
through the process. If the 
installer requests you to restart 
the PC, please do so, as the 
installation is not able to 
complete without the restart. 

• Choose Next to proceed. 

• Read the contents of the 
ReadMe screen. It 
contains timely 
information that may be 
required for the installation. Choose Next to proceed. 

• Choose the location for the program files to be installed to. Unless you have a 
particular reason for changing the default path setting, we recommend you leave it 
as is.  Choose Next to proceed. 

• Allow the program to 
create backup files for 
the installation. Choose 
Next to proceed. 

• Choose the components 
to install. If this 
machine is to house the 
hardlock, install the 
License Server 
component. 

• Documentation and 
tutorial files are 
installed to the same 
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directory as the program 
files. 

• Choose Next to proceed. 

• Select the name of the 
Program Manager group 
to add the icons to. 
Choose Next to proceed. 

• Once you’re happy with 
all the settings, choose 
Next to proceed, or 
choose Back to change 
any of your settings. 

• The program files are installed. 

• Once all the files have been installed, the Complete screen is shown. Choose 
Finish to complete the installation. 

Installing the Adobe Acrobat Reader 
If you want to view the application documentation, you will need to have Adobe Acrobat 
installed. If you don’t have the software on your system, use the installer on the CD. 

# Note: If you’ve installed ‘over the top’ of a demo version, you’ll find that the 
documentation on the CD is likely to be a much larger file than the one you 
downloaded.  Although the manual is the same, the version on the CD has images 
saved at a higher resolution. You won’t notice any difference viewing the manual on 
screen, but you will certainly notice a difference if you print it. 
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nderstanding PrintTime 

PrintTime allows the user to image files on a computer disk, whether that disk be a floppy, 
Zip, local hard disk, or a network drive somewhere. Files can be corrected for brightness, 
contrast, color balance as well as zoomed and cropped. 

Advanced features such as sophisticated hot folder support allow the user to create an 
automated package and image production environment. 

If you are using Timestone’s NeoPack+, PrintTime is also able to open Timestone Image 
Script files and print these to your printer. 

PrintTime’s main features 

Managing files 
PrintTime is designed to help you keep track of files that need to be imaged, have been 
imaged, and do so in an intuitive manner. Files are gathered together as bitmap files, 
Timestone Image Script files, queued files and printed files. The software allows 
automatic data gathering so removable disks don’t have to be present at imaging time to 
image the original files. Files can be re-submitted for printing, and changes made to the 
original order if required. This process is manual, and must be completed by the operator 
– ‘Cold’ mode. 

Creating package prints 
PrintTime allows simple creation of package prints from image files. Packages can be 
easily defined within the pack set editor. There are no restrictions on what packages can 
be created, as long as the printer can print the page size required by the pack, PrintTime 
can create it. Images are automatically rotated when the package is created – no operator 
intervention or special settings are required. 
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Figure 1: A package print 

Image cropping 
When creating package prints, it is important that your images are cropped correctly. 
PrintTime offers you on-screen cropping using the mouse or graphics tablet. If you are 
creating package prints, each image preview can display the aspect ratio boundaries, 
ensuring that the cropping you choose is suitable for all the aspect ratios that are to be 
printed. 

You have control on the image zoom, x and y image position. These controls can be 
adjusted either numerically from the image toolbox, or using the mouse. Images can be 
cropped individually, as a group of selected images or across the entire group of images 
currently open. 

 
Figure 2: Image cropping with aspect ratio preview 

Color, density and contrast corrections 
Image color and density can be adjusted from the image toolbox. You have control over 
Brightness, Contrast, Yellow, Magenta, and Cyan. 

Print Package sets 
Gather together print sizes together into a pack, or specify individual print sizes. You can 
gather collections of packages or print sizes together into a pack set, allowing single-click 
printing of complex print combinations. Multiple copies of the chosen print pack can also 
be specified. 
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Timestone Print Job file support 
Packages and other products created in Timestone Software’s Neo family of applications 
can be printed to a Timestone Print Job file. This results in a very short print times for the 
operator, allowing them to be more productive creating the packages. The more time 
consuming computer task can be handled by PrintTime, where the jobs are opened and 
released to the printer. No operator attention is required during this process. 

Extensive automated operation with ‘Hot’ folders 
PrintTime offers unattended printing to any Windows printer with its extensively 
customisable hot folders. Create folders on local or network drives, and attach various 
actions to that folder. Each time images are deposited to the folder, the action is carried 
out (color corrections, package, zooming or jogging) and the images are printed. 
Operating PrintTime with hot folders is called ‘Hot’ operation. 

Using PrintTime’s interface 
Once PrintTime has been installed, choose PrintTime from the Start menu > Program Files 
> Timestone Software. PrintTime will start. If you are asked for a serial number, or told 
that the software protection device is not present, please review Chapter 2, Installation. 

In the picture below, the PrintTime main window is shown in ‘cold’ mode. The program is 
shown here with an image file and print queue open. 

 
Figure 3: The PrintTime main screen 

 

PrintTime – Chapter 4 – Understanding PrintTime Page 9 
 



Understanding the interface 

Using the program tabs 
PrintTime’s main panes are divided by tabs. Choosing the relevant tab will display 
information specific to that tab. 

 
Figure 4: Use tabs to switch the program modes 

Selecting a preview mode for bitmaps 
There are various modes available to preview an image: 

Image ! 

! 

! 

Lens 
Pack 

Choosing the relevant radio button changes the image preview contents. 
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onfiguring PrintTime 

PrintTime comes with various default settings and packs. However, you will want to 
design print sizes and packages to suit your business. 

Setting the Program defaults 
Program defaults such as measurement and monitor calibration are set from the Options 
dialog. Choose File > Options. The Options dialog opens. 

 

Setting measurement units 
Choose either imperial or metric units of measurements. 

If you have defined packs in one measurement setting, PrintTime automatically converts 
the units in the Pack Setup dialog. 

Set the view size 
When displaying a pack preview, the display is relative to the size set here. For example, 
if a pack is 8 x 8", and the View size is set to a width and height of 20", the pack will 
appear quite small when previewed. Conversely, if a pack is 8 x 16", and the View size is 
set to 10 x 10, the pack will be clipped in the preview window. 
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Figure 5: The same pack with the View  setting set to 20x20, and 8x8 

Monitor calibration 
If you wish to use the built-in monitor calibration, ensure Enable monitor LUT is checked. 
If this option is enabled, the monitor calibration wizard must be run. See chapter 10 for 
more information regarding monitor calibration. 

Defining packages and pack sets 
PrintTime can create image packages, as well as printing files as a single print. All prints 
made with PrintTime are handled as a package. If a single print is required, a package with 
that single print must be created. 

How PrintTime handles Packages and Sets 
Package prints and pack sets are both created in the Package Editor. 
The editor is divided into two sections – Entries and Sets. 

Packages consist of an Entry, or the name of the package being 
created, and the print sizes that belong to that package. As many 
prints as are required can be added to a particular package, and the 
prints can be of different sizes, positions and orientations within a 
single pack. If an image needs to rotate for a particular print, it is 
automatically rotated. 

Each pack is defined by specifying the origin (the top left corner), 
width and height of the pack (the x, y, cx and cy entries). 

Once all the packages required have been created, they are gathered 
together into pack sets. When a set is chosen within PrintTime, the 
packages that have been added to that set are displayed for use. 

Pack sets can be chosen to make pack selection from the many 
defined packs easier. Only the packs than belong to a pack set are 
available when a set is chosen. The same packs can be placed into 
multiple pack sets if desired. 

Defining Packages 
Each package consists of a single description, and as many ‘lenses’ as required to make up 
the pack. Each ‘lens’ consists of 4 values: 
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x and y, the print origin ! 

! cx and cy, the print size. 

The units are those selected as the program defaults. 

Determining the origin 
Each print within a pack has an origin. The origin is the top left corner of each of the 
prints. 

4 3 

2 1 
Position 2 

Position 1 

cy 

cx Origin, 
x = 0, y =  0 

In this example, the origin of the prints are: 

 Print 1: x = 0, y = 0 
 Print 2 x = cx, y = 0 
 Print 3 x = 0, y = cy and 
 Print 4  x = cx, y = cy 

Designing a package – an example 
In an example, we wish to create the following package for use within PrintTime. 
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Step 1: Create the pack entry 
Make sure the program default measurements are imperial (File 
> Options). Open the pack editor, and create a new entry in the 
Entry list. Name the entry Pack A. 

Step 2: Create a new lens set 
Choose Add. A new line appears in the Lenses for entry table. Enter the following values: 

x = 0 (x origin) ! 

! 

! 

! 

! 

! 

! 

! 

y = 0 (y origin) 
cx = 8 (print width) 
cy = 10 (print height) 

Choose Add again. A new line appears in the Lenses for entry table. Enter the following 
values 

x = 8 (x origin) 
y = 0 (y origin) 
cx = 7 (print width) 
cy = 5 (print height) 

Continue adding entries until all the below values have been entered: 

Print x value y value cx value cy value 

Print 1 0 0 8 10 

Print 2 8 0 7 5 

Print 3 8 5 7 5 

Print 4 15 0 3.5 5 

Print 5 15 5 3.5 5 

Print 6 18.5 0 3 2 

Print 7 18.5 2 3 2 

Print 8 18.5 4 3 2 

Print 9 18.5 6 3 2 

Print 10 18.5 8 3 2 

Create a new pack set 
Once you have designed all the required packages, they 
need to be placed into a pack set. As many packs as are 
required can be placed into a pack set. 

It is useful to name and gather the packs into pack sets for 
easy selection. For example, you may have a number of 
single print sizes defined as well as packages that fit on an 
A4 page. It is sensible to gather the single prints together 
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into a Single Print set, while all the A4 packs are gathered to the A4 Packs set. 

If the package editor window isn’t already open, open it by choosing Edit > Packs… the 
package editor opens. Choose the Sets tab. 

Step 1: Create and name the pack set 
Choose New from the Set list section. A new line appears in the Set list table. Enter some 
meaningful name that identifies this pack set. 

 

Step 2: Add packs to the set 
Choose Add from the Packs in set section of the dialog. A new line appears in the Packs in 
set table. Note that the Pack entry has a drop-down button. 

 

Click the drop-down arrow. A list of available packages is displayed. Choose the package 
you wish to add. 

 

Click inside the Description field and name the pack. This is the name that is displayed in 
the program to identify this particular package 

Continue adding packs to the pack set as necessary. Once finished, choose OK. The dialog 
is dismissed 
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dding files 

There are several different types of files, and modes of operation PrintTime can handle. 

Individual image files ! 

! 

! 

! 

! 

! 

! 

Timestone Image Script files; special files from other Timestone 
Software applications 
Batch operation – add image and Script files to a special batch folder 
Hot and Cold operation 

When individual image files are added to a printer queue, they can be corrected for color, 
density and contrast, as well as being zoomed and cropped. Single prints or packages can 
then be selected. Prints are sized automatically to create the desired print size, or using the 
file’s dimensions. Script files are already formatted, and so only the color, density, 
contrast and required quantity can be adjusted. 

Files can also be added to a batch of files. Batches ensure that files are printed together as 
a group, ensuring a particular job isn’t mixed with images not belonging to that job. 

Finally, PrintTime allows either Cold operation where files must be manually added to a 
queue or batch, or Hot operation where files and batches are automatically added using 
special Hot folders. For information regarding this Hot operation, see a later chapter. 

Choosing files to add 
Choose the directory that contains the files you wish to image by either; 

Typing the directory location in the Path 
Clicking the folder icon and choosing the location 
Choosing a previously chosen path from the Path 
drop-down. 

 
Bitmap and Timestone Image Script files are automatically recognised, regardless of their 
file extension. This includes some file formats from other operating systems such as 
MacOS, UNIX etc. 
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The following file formats are recognised: 

TIF ! 

! 

! 

! 

! 

! 

TARGA + TARGA compressed 
BMP 
PNG 
JPEG 
Mac PICT 

All valid image files will appear in either the Bitmap Files tab and Timestone Image Script 
files in the Image Script tab. An image thumbnail will be generated for all the bitmap files. 
If the images are quite large, it may take a little time to generate the thumbnail, but this is 
handled as a background task, and the software will still allow operations during this 
process. 

Any Timestone Image Script files will show the created pack or other items created in any 
of the Neo applications. 

  
Figure 6: File listing of bitmap and Image Script files 

Sorting files 
Files can be sorted by alphabetically, numerically or by date / time stamp. This is useful 
when adding files to the queue in a particular order. Click on the button you wish to use as 
the sort criteria – any files displayed in the Files tab will be sorted. 

 
Files added with Are sorted… 

Alphabetical sort Alpha-numeric sort (abc123…) 

Numeric sort Strict natural order (9, 10, 11) numeric sort. Normal numeric sort 
can result in sort order 1, 10, 2, 3… Alphabetical characters are 
ignored. 

Date / Time stamp sort Sorted according to the file creation time. 

 

 

Alphabetical sort

Date / Time stamp sort Numeric sort
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Preparing bitmap files 
It is possible to correct density, color, contrast, as well as zoom and crop images as they 
are added to the queue. 

Choose the view 
Choose the file you wish to add. A larger view appears in the centre pane. Choose one of 
the three views available by clicking the radio button: 

Image – previews the image or script file ! 

! 

! 

Lens – previews the image with the defined aspect ratios for cropping 
Pack – previews the selected image pack 

# If you are viewing Image scripts, the radio buttons are not available as it is only 
possible to correct the image. A preview is still shown. 

 

  
Figure 7: Centre pane preview showing Image, Lens and Pack modes 

Color correct the image 
Choose Image preview mode. Enter the color or density corrections required using the 
color and density controls. The keyboard can be used to enter the corrections by typing the 
color or density key (R, G, B, D) and then the required amount. For example, a correction 
of +2 Green +2 Yellow and –3 Density would be achieved by typing: 
 G+2B-2D-3 

Corrections made here are ‘sticky’. As new images are added to the printer queue are 
applied to the images. Corrections are remembered for each individual image and can be 
changed by choosing the file once it has been added to the Unprinted tab. Choose the 
Reset button to reset all the values. 
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 Reset settings

 

 

 

 

Green value 

Blue value 

Red value

Contrast value

Brightness value

Task Action 

Lighten or darken a print Increase or decrease the I amount, or type Ctrl-I 
immediately followed by the amount (i.e. +2, -1) 

Make the print more red or cyan Increase or decrease the R amount, or type Ctrl-R 
immediately followed by the amount (i.e. +2, -1) 

Make the print more green or magenta Increase or decrease the G amount, or type Ctrl-G 
immediately followed by the amount (i.e. +2, -1) 

Make the print more blue or yellow Increase or decrease the B amount, or type Ctrl-B 
immediately followed by the amount (i.e. +2, -1) 

Add the corrected print to the queue Choose Add 

Add the same corrections to many 
prints 

Make the required corrections, choose the file then 
choose Add 

Reset settings Press the reset button. All values are set to zero. 

 

Zoom and crop the image 
Images can be moved and re-sized to create the best cropping for various aspect ratio 
prints. When in cropping mode, PrintTime displays any enabled aspect ratios. Images 
should be cropped so that each of the different aspect ratios will appear pleasingly 
cropped. 

Choose the Lens radio button. The preview images changes to show any active aspect 
ratios. Use the mouse and thumbwheel to zoom and crop the image. 

Choose the Reset button to set all the values to default. 

 
Zoom value

Horizontal shift value
Horizontal shift value

 
Reset settings
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Crop an image 
Choose an image. The image can be moved by: 
 

Action Mouse Image Correction palette 

Move an image left Click and drag the mouse Decrease the X value 

Move an image right Click and drag the mouse Increase the X value 

Move an image up Click and drag the mouse Decrease the Y value 

Move an image down Click and drag the mouse Increase the Y value 

Reset cropping  Press the Reset button 

 

Zooming images 
Choose an image. The image can be zoomed by: 

Action Mouse Image Correction palette 

Make the image larger Click the preview and turn the 
scroll wheel 

Increase the S value 

Make the image larger Click the preview and turn the 
scroll wheel 

Decrease the S value 

Reset the zoom ratio  Press the reset button 

 

Choose the print size or package and quantity 
Choose the desired print size or package from the pack drop-down. Choose other pack sets 
by clicking the Pack set button. Choose the desired set from the list of choices. The print 
sizes and packs that belong to that set become available. Enter the required number of this 
print or pack in the Quantity box. 

Choose the Pack radio button to preview the print or package chosen. 

 
Choose the print quantity 

 Choose the print or pack required
Click to choose a different pack set 

Switching Pack sets 
Switch between the pack sets you have defined by clicking the 
Pack Set button. A drop-down window with the available sets 
appears. Choose the set you want. 
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Setting file options 
PrintTime allows you to choose how files are handled as they are added to the printer 
queue, and after being imaged. 

There are three options: 

No special file handling ! 

! 

! 

Print from a copy of the file 
Delete file after printing 

No special file handling 
When a file is added to a print queue, the original file is used to print. This means that the 
file must still be available in order to be printed 

Print from a copy of the file 
When the file is added to the queue, its image data is copied to a temporary file. This 
means that the original file doesn’t have to be present to image correctly. This is useful 
when imaging from a removable or network disk or a floppy. 

Delete file after printing 
If the option Delete file when finished is checked, any files added to the Unprinted queue, 
and then printed are marked for deletion. 

There are further options in the Printed tab that control when the file is finally deleted. For 
example, if the keep reprint information checkbox is checked, the file won’t be deleted 
until its entry in the Printed list is removed, or the program is quit. 

Be careful when using this option! 

 

Adding the file 
Once all the various options and corrections have been set, click the Add 
button or double click the file. The resulting print or pack is added to the 
printer queue. The same file can be added many times to the printer queue 
with different cropping, corrections, print sizes and packs. 

Files are added to the Unprinted tab. 
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Figure 8: Unprinted images in the current queue 

Editing files in a queue 
Once a file has been added to the queue, the settings for a particular print can be edited by 
clicking the image in the queue. Choosing the image will display that image in the 
preview pane. Change any of the settings as required. 

Managing prints in a queue 
Prints in a queue can be removed, held or released. 

Delete – deletes a file from the queue permanently. To delete an 
image from the queue, click its entry, then the Delete button. The 
entry is removed. 

! 

! Pause – Holds the print within the queue. Prints that are held will 
not be printed when the printer is started. If a print is held in the 
queue, it is indicated by a pause marker. To release a paused 
image, click the Pause button again. The image can now be printed. 

 

Batch printing 
Some groups of image files belong to a single job. In this case, you will want all the files 
printed together, un-interrupted by other files. 

Batches can be defined within the Unprinted queue by adding a job folder. Files are then 
added to the folder, and are handled as an individual job. All files from this folder will be 
imaged before any others, unless the batch is cancelled. 

Batches can consist of individual files, as well as Image Script files. 

Create a new batch 
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Click the New batch button. A folder is added to the Unprinted queue. 

 

Note that the folder is open, indicating any files added will be added to this new batch. 

Add files to the batch 
With the folder still open, add image or Timestone Script files as normal. Files will be 
added to the batch as usual. Note that members of a batch are nestled under the batch 
folder. The folder can be expanded or collapsed as in Windows Explorer by clicking the + 
or – symbol in the queue list.  

  
Figure 9: Batch folders expanded and collapsed. 

Opening or closing a batch 
Once all the necessary files have been added to the batch folder, 
close it by clicking the Close Batch button. 

Once a batch has been closed, it can be opened for adding further 
files by clicking the batch, then the Open Batch button. 

  
Figure 10: An open and closed batch 

Pausing a batch 
If you want to print other files in a queue but are not yet ready to print a 
batch, pause the batch by clicking it in the list, then the Pause button. 
The batch won’t be printed until it is released. 

A paused batch is indicated by the pause markers over the batch folder. 
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rinting the queue 

Whether files have been added to a queue individually or to a batch, they are handled in a 
similar manner when printed. Both image and Script files are handled in the same manner, 
the only difference being the corrections available. 

Any standard Windows printer driver can be used to print images. Timestone Software has 
special printer drivers that enhance the possibilities when printing packages. Any special 
properties are discussed in that driver’s user documentation. 

Configuring and controlling paper sizes 
As with any application, PrintTime needs to know which printer is currently being used. 
You should follow your printer driver’s documentation for configuration information. 

From the File menu, choose Setup printer. The printer setup dialog is shown. 

 

Choose the printer Open Printer properties 
dialog 

d print functions; only available if 
supported by the print driver. 

Index line configuration 

Output file path 
File output options 

Output file naming 

Output file naming options 
Printer LUT settings 

Figure 11: Print setup dialog 
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Choosing the printer 
Choose the desired printer by clicking the arrow in the Name drop-down, then choose the 
printer from the list. 

 

Set the printer properties 
The Windows printer properties can be set by choosing 
Properties from the print setup dialog. Once the printer properties 
dialog opens, follow the manufacturer’s instructions to set the 
necessary parameters. 

In particular, ensure that the page size is able to print the packages you have designed. 

Automatic paper orientation 
When printing to a ‘normal’ printer, NeoPack will automatically adjust the orientation of 
the printer’s paper to match the package being printed. Enable this option by choosing 
Automatically adjust orientation. 

Automatic orientation of a ‘bitmap’ printer 
As discussed previously, PrintTime allows you to ‘print’ to many new digital photographic 
printers by printing its jobs to bitmap files. These files are then submitted to the digital 
photographic printer by a server software. These printers often require that the image be 
presented in a particular orientation (portrait or landscape), meaning that the orientation of 
the printed bitmap must be changed as required. 

When printing to Zenographics SuperPrint drivers, PrintTime will print the file in the 
orientation the bitmap driver is currently set. For example, if the packages have been 
designed in a landscape orientation, but the printer driver is set to portrait, PrintTime will 
print the image in a portrait orientation to match the driver. 

# This rotation can take a number of seconds to perform, depending on the size of the 
final print. To avoid this time, make sure you design your packages in the correct 
orientation for the printer. 

Automatic paper size selection 
PrintTime can automatically choose the most appropriate page size for an image being 
printed. Within a particular print job, there may be a number of different page sizes 
required by the printer queue. Pack A might require a page size of 8 x 20.5", while Pack B 
might need 8 x 11.5". Printing these packages on a single page size is wasteful of paper. 
PrintTime can automatically choose from the available paper sizes from most Windows 
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printer drivers, or automatically generate the exact paper size when using a Timestone 
Software Windows printer driver. 

When using standard Windows printer drivers, the physical printer must of course be able 
to automatically change the paper size to use this feature. In the main, this feature is best 
used with Zenographics SuperPrint bitmap drivers to send to a photographic style digital 
printer that can automatically vary the paper size. 

Timestone Software printer drivers automatically control the photographic printer to 
create the exact paper size required. 

Using best paper sizes 
Choose Setup printer from  the File menu. The Print setup dialog is shown. Enable best 
paper size selection by choosing Pick best paper size from the Printer options section. With 
this option enabled, PrintTime will check all the available paper sizes, and chooses the 
closest match for the page currently being printed. This check is performed for each job, 
meaning that a queue can contain different size prints-  the best paper size will be selected 
for each page being printed. 

Use custom paper sizes only 
Most print sizes PrintTime is required to create are not standard (A4, Letter) sizes. Printer 
drivers that allow custom paper sizes to be created allow you to design sizes that are 
exactly correct for PrintTime prints. In this case, it is not desirable to allow PrintTime to 
automatically choose a standard paper size, as it may not be exactly correct. 

Choose Use custom paper sizes only. PrintTime will only consider custom paper sizes 
when automatically choosing the one to be used. 

 

# When using this feature with the Index line enabled, be sure to allow enough room 
for the index line when defining the paper size dimensions. If the paper size is too 
small to include the index line, the next larger size will be chosen, resulting in un-
predictable results. 

Package Index Lines 
PrintTime allows creating Index Lines that can be positioned at a particular position on 
each package printed. The Index Line can contain information such as the source file, 
corrections, image number, and a number of other options. 

Other Neo applications also support index line information. When printing Image Script 
files, PrintTime can use the index line settings specified when the file was created by the 
other Neo application. These settings can also be over-ridden if desired. 

There are different settings available when printing bitmap or  Timestone Image Script 
files. 
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Figure 12: An Package Index Line 

Enabling Index Line printing 
PrintTime supports separate settings for either Bitmap or Script files. Settings made for 
one do not affect the other, so it is possible to configure the index line specifically for 
either file type. 

Choose either the Bitmap or Scripts tab. Enable Index lines checking Index line on within 
desired tab.  

 

Image alignment 
Normally, if the  paper size chosen is bigger than required, the alignment of the printed 
image on the page can vary according to how the printer driver handles the mismatch. 
Using the Align setting, the image can be aligned to a specific position on the page. 

Choose the desired alignment by clicking the Align drop-down, then choosing from the 
available alignments. 

Configuring the Index line 
Click the Configure button. The Index Line setup dialog is displayed. 

 
Figure 13: The Index Line options panel 
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Setting the Index Line options 

Setting the Height 
Choose the height of the Image Line in Points. The Image Line text will be automatically 
scaled to fit within the height. 

 

Specify the gap to the Index Line 
Specify the gap amount to leave between the Package print and Index Line. This amount 
is specified as a percentage of the Index Line height. 

 

Set the Index Line position 
Choose the position for the Index Line to appear. Choosing Anywhere allows NeoPack to 
automatically choose the most appropriate position for the Index Line. 

 

Set the text alignment 
Choose Left, Centred or right alignment for the Index Line text. 

 

Choosing the Index Line content 
There are different contents and settings available for either bitmap or script file index 
lines.  

There are a number of items that can be included in the Index Line. These 
options can be added to the current Index Line by clicking the Text options 
drop-down. A list of pre-defined codes appears. Choose the desired code, and 
it is added to the end of the current text selection. It is also possible to enter 
text to the Index Line. 

Option Description 

Description (Hot 
folders only) 

The Hot Folder description that created the print 

Original line text 
(Scripts only) 

Index line information specified in the originating Neo application 
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Path + Filename Source NeoPack filename and the path to that file 

Filename Source NeoPack filename 

Date Date the job was printed from NeoPack 

Time Time the job was printed from NeoPack 

Corrections  Color and density corrections for this pack 

Pack Package selected 

 

  
Figure 14: Index Line text options for bitmaps (left) and scripts (right) 

Using printer corrections 
PrintTime allows printer corrections by applying a LUT to the image as it is printed. This is 
especially useful if you have more than one printer in use, and you switch between them. 
It is also useful to calibrate your printer to the computer’s monitor. 

To choose a correction, click the Apply LUT drop-down box. 

Printing to a bitmap 
Normally, an application uses a standard Windows print driver to print a page. However, 
some of the newer photographic digital printers will only image bitmap files. Many of 
these printers don’t have Windows printer drivers available at all. 

If your printer is in this category, it is possible to ‘print’ to a bitmap file using printer 
drivers such as Zenographics SuperPrint™. These are a set of Windows printer drivers 
that create bitmap files instead of printing to a physical printer. These bitmaps can then be 
submitted to your printer. 

Configuring a bitmap printer driver 
If you’re using a bitmap style driver like SuperPrint to print to your printer, you need to 
understand how your printer needs to receive the final printed bitmap files. This involves 
understanding the desired page size, and the resolution (dpi) that the printer is set to. 

SuperPrint also has some useful image enhancement features when imaging the resulting 
files to a photographic style printer. 

Setting the output filename options 
In order to use the bitmap drivers, it is necessary to specify the output filenames of the 
resulting bitmap files. Important if you are printing 100 packages! 
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Enable file naming 
Enable the file naming feature by checking Print each page to individual file. If you are 
using a normal Windows Printer driver, this will create a Windows Print file. If you are 
using a Zenographics bitmap driver, this will create a bitmap file. 

 

Choose the destination 
Choose the final destination of the image files by either typing the path, or click the 
Browse button and browse for the destination folder. 

 

When printing with these settings, each page is printed to an individual file. There are 
various options available to control the filename allocated for each page. 

There are three options to choose from: 

A prefix (characters always at the beginning of the filenames) ! 

! 

! 

! 

An image identifier (information that identifies each printed file) 
Number of copies (the number of copies requested) 
File extension (the image file extension) 

 

Prefix 
The prefix is the first characters of each filename created. Each file created for a particular 
job will start with whatever is entered here. 

Identifier 
The number can be either the Original filename base or a Sequential number. 

Option Description 

Original filename 
base 

PrintTime uses the original filename as the number information. 

Sequential no. PrintTime numbers this field with a sequential number. The starting 
number can be specified by entering a number in the next number field. 

Copies 
The chosen number of copies is automatically entered. 
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Extension 
The characters used as the file extension. 

Using printer corrections 
NeoPack allows printer corrections by applying a LUT to the image as it is printed. This is 
especially useful if you have more than one printer in use, and you switch between them. 
It is also useful to calibrate your printer to the computer’s monitor. 

To choose a correction, click the Apply LUT drop-down box, and choose from the available 
corrections. 

See chapter 11 for more information regarding using and constructing corrections for use. 

Configuring the Printed tab 
Once files have been printed, they can be added to the 
Printed tab if required. There are several options that 
control how queue entries are handled after individual 
files have been printed. The entire entry for an image file, 
batch or script file can be moved to the Printed tab, 
allowing it to be re-printed at a later time. It is also 
possible to add just the file entry name, making it 
impossible to re-print, but cat as confirmation the file has 
been printed. Finally, entries can be removed entirely, 
with no entries appearing in the Printed tab as files are printed. 

 
Option Description 

Put in list Once a file has been printed, its entry in the Unprinted queue will be moved to 
the Printed queue. If this option is not checked, the entry will be deleted 
immediately the file has been printed. 

Keep reprint 
information 

Allows the file to be re-printed at a later time. If this option is not chosen, it may 
not be possible to re-print the file. 

Printing and using the queue 
Once all the necessary settings have been made, and images have been added to the queue, 
PrintTime can print the images. 

Starting the printer 
The printer is set printing by choosing OK to print. Once this is chosen, the printing 
process will start. As an image is printed, it will be removed from the Unprinted tab, and 
placed into the into the Printed tab according to the settings made there. 

Printing is handled as a background process, so it is possible to add, edit and pause files as 
the queue is being printed. 
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Pausing the printer 
To pause the printer during the printing process, uncheck the OK to print checkbox. The 
traffic light turns to yellow as the current print is completed, and then to red as the printer 
is stopped. 

  
Figure 15: The printer is stopping, then stopped 

Re-starting the printer 
To restart the printer, choose OK to print. Printing starts again. 

Using the Printed tab 
Depending on how the Printed tab options were set when a file was printed, a file’s entry 
may have been moved from the Unprinted to the Printed tab. Entries within the Printed tab 
can allow images to be re-submitted for reprinting, or act as a confirmation that a file was 
printed. 

Removing a single Printed entry 
A single entry can be removed from the Printed queue by choosing 
the entry to remove, then pressing the Delete selected button. The 
selected entry is removed from the Printed queue. 

Remove all Printed entries 
All entries in the Printed queue can be removed by clicking the Remove All button. When 
this is done any entries currently in the Printed queue are removed. 

Re-printing prints 
Once a print has been sent to the printer once, it is moved from the Unprinted 
tab to the Printed tab. Once in the Printed tab, it can be removed altogether 
from the queue, or re-printed. 

To re-print a file, choose it in the Printed tab, then click the Reprint button. If 
the option keep reprint information was not checked when the file was 
printed, this button will not be available. 
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Printing batches 
Once all the files have been added to the batch, it is printed in the normal fashion by 
checking OK to print. If a batch is still open, it will not be printed. 

Once PrintTime starts printing the batch, it will work its way down the list of images until 
it is either paused, or all the files are completed. As individual files with a batch are 
printed, they are ‘dimmed’ in the display, indicating they have been printed. 

  

Once all the files have been printed within a batch, they will be added to the Printed tab 
according to the options set here. 

 

Pausing a batch while printing 
If you need to pause the printing of a batch while it is being printed, uncheck OK to print. 
A confirmation dialog will be displayed. Confirm the pausing of the batch – the batch is 
pauses. When you are ready to start printing the batch again, check OK to print. 

  

Re-printing batches 
If the put in list and keep reprint information checkboxes were checked 
when a batch was printed, it is possible to re-print  a batch. To do this, 
open the Printed tab and click the batch you wish to reprint. 

Click the Reprint button. The batch is moved from the Printed to Un-printed tab ready to be 
printed again. If the option keep reprint information was not checked 
when the file was printed, this button will not be available. 
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Timestone Software’s other products are tools that create prints, packages, ID cards, 
composite images and other items that you may design. PrintTime and Timestone Image 
Script files create a very efficient production workflow. 

This is achieved by using Timestone Image Script files and multiple workstations running 
PrintTime, all feeding prints into your high-volume digital printers. These files are created 
by the operator ‘printing’ to a Timestone Image Script file instead of directly to the printer. 
The file contains all the image, print, pack and other information used to create the print. 
PrintTime can then open the file and re-create the product, even though it is not capable of 
creating the file in the first place. 

As PrintTime can run as an un-attended application, it can be set to print a queue of 
images while your operators continue to quickly create more product. 

Using Timestone Image Script files 
In order to create a Timestone Image Script file, you must have a Timestone Software 
application that supports this file format. 

In the originating Neo applications, choose Print Setup from the File menu. The printer 
setup dialog is displayed. Choose Timestone Image Script file as the target printer. A 
Timestone Image Script file will be created when the job is printed. 

Adding Script files 
Once created, the Timestone Image Script files are opened by PrintTime in the same way 
as simple bitmap image files. However, they appear in the Script file tab instead of the 
Bitmap files tab. 

The file directory can contain both bitmap and script files. The different types are 
automatically recognised, regardless a files extension, and placed into the correct program 
tab. 

Displaying a Script file 
Choose the directory that contains the Timestone Image Script files, then the Script files 
tab. The Timestone Image Script files are displayed. 
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Figure 16: The Script tab with image scripts 

Choosing a script file in the file listing shows a preview of that file. 

 
Figure 17: An Image Script preview 

It is possible to adjust the color and density of the script file, as well as the quantity 
ordered. However, as the print has been designed and printed from another application, it 
is not possible to zoom or jog the image. If these adjustments are required, they must be 
done in the originating application. 

Color correct the image 
Choose Image preview mode. Enter the color or density corrections required using the 
color and density controls. The keyboard can be used to enter the corrections by typing the 
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color or density key (R, G, B, D) and then the required amount. For example, a correction 
of +2 Green +2 Yellow and –3 Density would be achieved by typing: 
 G+2B-2D-3 

Corrections made here are ‘sticky’. As new images are added to the printer queue are 
applied to the images. Corrections are remembered for each individual image and can be 
changed by choosing the file once it has been added to the Unprinted tab. 

Choose the Reset button to reset all the values. 

 

 

 

 

 

Green value 

Blue value 

Red value

Contrast value

Brightness value

Reset settings

Printing Timestone Image Script files 
An Image script file can be managed within a queue exactly as if it were a normal bitmap 
file. However, as the originating application has set the image cropping, positioning and 
other such application-specific items, none of these controls are available from PrintTime. 
It is possible only to: 

Adjust the overall color balance, density and contrast of the item ! 

! 

! 

Change the number of prints created 
Override the Index line contents 

# Any color corrections, Index line information or LUT corrections applied within the 
originating Neo application will be honored in PrintTime. 

Script files can be added to the print queue via the hot folder mechanism, exactly as 
bitmap files. When the TIS files are created by the originating Neo application, a matching 
TIB file is created. This file contains batch information for the TIS files. 
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Hot Folders: An overview 
A folder can be set to treat files as members of a batch or as individual files. PrintTime can 
be set to check the special folders at regular intervals – for example, every 60 seconds. 

If files are found inside an individual file folder, they are added to the ‘unprinted’ tab, and 
will be printed in turn. Each of the hot folders is searched one after the other, in the order 
shown in the hot folder list, and files added in that folder order to the Unprinted tab. 

If a folder that has batch printing enabled is found with new files, PrintTime checks to see 
if the ‘batch’ settings have been satisfied. If the conditions have not yet been met, 
PrintTime passes over this folder and continues to the next. Once the batch conditions are 
met, the files are added to the Unprinted tab as a job, and will be printed together. 

Once files have been added to the Unprinted tab, they are handled as normal within 
PrintTime. Depending on the options set for a hot folder, files will either be re-named to 
an in-eligible filename, moved to a new folder or deleted from the hot folder once printed. 

Creating hot folders 
Choose the Automatic Settings tab. The Hot folder settings are shown. 

 
Figure 18: The Automatic Settings screen. 
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Defining new hot folders 
Choose New – a new hot folder entry is added to the list. Make the following entries to the 
General tab. 

 

Enabling the hot folder 
Switch the hot folder on or off by checking or un-checking Enable this folder. 

Specify the hot folder 
Either type in the path to the hot folder, or choose Browse. A directory browser is 
displayed. Choose the correct folder and choose OK. You can specify a network path if 
desired. If this is done, it is important to ensure that the current operator has permission to 
read files from the remote folder. 

 

Enter a folder description 
Enter a description for the entry. 

 

Include or exclude sub-directories 
PrintTime can scan the sub-directories of a hot folder for eligible files. This is useful for 
convenient folder drop operations from the operator’s workstation. With this option 
enabled, the operator simply copies the whole folder containing the files to be printed to 
the hot folder. 
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Batch processing 
Hot folders can either consider files within a folder as a part of a job (and so required to be 
printed together, without other files mixed in), or as individual files. 

Defining a folder as a ‘batch’ folder 
Choose the folder you wish to define as a batch folder, then choose the Batch tab. The 
folder is made a batch folder by checking Enable batch printing for folder. 

 
Figure 19 The Batch settings 

Activity based batch handling 
When files are copied to a hot batch folder by another application or user, it is possible for 
files to be added in different ways: 

The whole batch of files are copied in a single operation (all files appear 
in the hot folder quickly one after the other) 

! 

! Files are ‘printed’ to bitmaps from the application directly from the 
application (the files appear with a significant time gap between files) 

If activity based monitoring for a batch of files is used, it is important that the setting 
made here is done carefully. 

# Note: If there are several operators creating or copying files to a hot folder at the 
same time, they should separate their files to different sub-directories to avoid 
mixing jobs. Make sure that the hot folder has the Include subdirectories as well 
option checked. 

If the whole batch is copied as after all the files have been created on the operator’s 
workstation, set a short time in the when there is no activity for xx minutes field. 

If the files are being created in the hot folder by printing directly from the originating 
application, use a longer time. 

# The best time to enter as the activity value depends on many 
variables, including the time taken to create a single file, network 
traffic. In practice, if files are created within a sub-directory specific 
to a particular workstation, set the value to a higher number rather 
than a low one. 
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Special file identifier 
An alternative method of indicating a batch of files is complete is to copy a special file to 
the hot folder at the end of printing from the application or after all the files have been 
copied. 

Once this file is seen by PrintTime, all the files contained within the hot folder at that 
moment are treated as a job and added to the Unprinted tab. 

The contents of the file itself is un-important. PrintTime only checks for a particular 
filename. You could create a blank document within Notepad, and save it with the special 
filename to the hot folder. 

When specifying the file to use, you can use wildcards such as printnow.* 

 

While this method does involve an additional step, it is a good way of ensuring the files 
are printed as a job. 

Sorting a batch 
Once a group of files become eligible to be added to the queue, they are first sorted, and 
then added to the Unprinted tab for printing. 

The sort options are set in the Print batch sorted by section. 

Sort by Description 

Filename Files are sorted alphanumerically by their filename. This option may 
not correctly order files named by sequential numbers. 

Numerically Numerical sort order. This ensures natural counting order is 
maintained. Any alphabetical characters are ignored with this sort. 

Time Files are sorted by their modification date / time stamp 

Reverse order Reverses the sort order (Z – A) 

 

 

Batch handling for Timestone Image Script files 
Timestone Image Script files are automatically identified as a batch by a special TIB file. 
This file is created at the same time as the script files themselves, and identify all the 
members of a particular batch. 

When the originating Timestone Software package begins printing to a Script file, it first 
creates the TIB file. PrintTime will not start printing the Script file until it sees that this 
file is completed. 
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Be sure that the TIB file is copied across with the other TIS files to maintain the batch 
information. Other batch criteria can also be used to identify TIS files as a batch as 
previously discussed. 

Applying image corrections and packages 
Image corrections such as density, color, contrast, image scaling and jogging can be 
applied to bitmap files as they are printed. This means that any files dropped into a folder 
can be (for example) zoomed, and color corrected as they are printed. 

Corrections apply globally to any file dropped into the hot folder, with the exception of 
Timestone Image Script files. These files can be color corrected, but no zoom, jog pack or 
multiple copies will be created unless specified in the originating application. 

Specify the corrections 
Click on the hot folder you wish to edit and choose the Pre-processing tab. Enter the 
required corrections, including zoom, jog, copies and pack. If PrintTime encounters an 
Timestone Image Script file within this hot folder, it will ignore these settings, but apply 
the color corrections. 

 

Creating packages and multiple copies 
PrintTime will create an image package from each bitmap as specified in the Pack drop-
down. All packs that have been created will be displayed, regardless of the pack set. 
Choose the package you wish to be created by choosing it from the drop-down list. 
Similarly, if multiple copies are required from a single image, specify the number in the 
Copies box. 

If your application creates images correctly sized, choose Same Size from the Pack drop-
down. Prints will be created using the image file’s original resolution and dimensions (if 
possible). 

Timestone Image Script file corrections 
As an image script contains corrections such as color, density, cropping and package, it is 
not necessary to make the corrections in PrintTime. 

It is not possible to change zoom, crop, pack or copies ordered within a image script file. 
Color, density and contrast and be changed. Any invalid settings are ignored when 
printing a script file. 

Printing files from hot folders 
Once eligible files have been added to the Unprinted tab, they are handled exactly as if 
they had been manually added as a file. 
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The exception is that files added as a batch are still recognised as a batch, and printed as 
such, as long as the printer driver you are using supports job printing. This means that if 
there are multiple PrintTime stations printing batches to a printer, the batches will be 
honoured and printed together without mixed prints. 

It is still possible to edit the settings of images added from a batch. Simply choose the 
image within the Unprinted tab. Any settings are displayed, and can be changed. 

To start printing the files, turn the printer On by checking the OK to print checkbox. 
PrintTime starts printing the files. 

File handling after imaging 
Post-processing options are set by choosing the hot folder you wish to edit, then the Post-
processing  tab. Several actions are possible after files have been printed to ensure they 
are not re-added to the Unprinted tab again: 

Delete the file ! 

! 

! 

Rename the file 
Move the file 

Delete the file 
Once the files have been printed, they will be deleted from the hot folder. 

Prefix files with… 
Once the files have been printed, they will be re-named by prefixing with this character. It 
is possible to use a single or multiple characters. 

PrintTime will ignore any files found with this prefix. 

Move files 
Once the files have been printed, they will be moved from the original directory to the 
specified directory. The directory cannot be an absolute path (eg. C:\Printed), but must be 
a sub-directory of the hot folder directory. 

PrintTime will ignore any files found in this sub-directory, even if include subdirectories 
as well was chosen in the General tab. 
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10

– Calibration & Color Management 
# Note: Timestone Software’s Neo family of products (including PrintTime and 

RipTime) use the ICC color management system that Microsoft has built into 
Windows 2000. If you are using Windows 2000, you should use the ICM-2 color 
management system in preference to taking the steps described in previous versions 
of this manual. 
 
ICC color management involves creating ‘color profiles’ for every display or output 
device on your system, and is considerably more sophisticated than the previous 
method. 
 
However, the ‘calibration’ method of color management, and the creation of LUTs 
(Look-Up Tables) to achieve consistent color correction is still valid if you have not 
yet upgraded to Windows 2000, and both methods are now described in our 
separate Color Management Guide, which should be available on the same CD-
ROM that this manual was on – or you can download it from our website at:  
http://www.timestone.com.au  
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